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Features

==/ 1. About These Megafunctions

The Altera® DDR I/O megafunctions configure the DDR I/O registers in APEX™ II,
Arria® series, Cyclone® series, HardCopy® series, and Stratix® series devices. You can
also use the megafunctions to implement DDR registers in the logic elements (LEs). In
Arria GX, Stratix series, HardCopy II, HardCopy Stratix, and APEX II devices, the
DDR registers are implemented in the I/O element (IOE). In Cyclone series devices,
the megafunctions automatically implement the DDR registers in the LEs closest to
the pin. The ALTDDIO_IN megafunction implements the interface for DDR inputs.
The ALTDDIO_OUT megafunction implements the interface for DDR outputs. The
ALTDDIO_BIDIR megafunction implements the interface for bidirectional DDR
inputs and outputs.

The ALTDDIO megafunctions implement a DDR interface and offer the following
additional features:

m The ALTDDIO_IN megafunction receives data on both edges of the reference clock

B The ALTDDIO_OUT megafunction transmits data on both edges of the reference
clock

m The ALTDDIO_BIDIR megafunction transmits and receives data on both edges of
the reference clock

m Asynchronous clear and asynchronous set input options available

m Synchronous clear and synchronous set input options available for Arrix GX and
Stratix series devices.

B inclock signal to sample the DDR input

m outclock signal to register the data output

m  Clock enable signals

m Bidirectional port for the ALTDDIO_BIDIR megafunction

B An output enable input for the ALTDDIO_OUT and ALTDDIO_BIDIR
megafunctions

Device Support

January 2013  Altera Corporation

The ALTDDIO megafunctions support APEXII, Arria, Cyclone, HardCopy, and
Stratix device series.
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Common Applications

DDR registers capture and/or send data at twice the rate of the clock or data strobe to
interface with a memory device or other high-speed interface application in which the
data is clocked at both edges of the clock. The DDR registers interface with DDR
SDRAM, DDR2 SDRAM, RLDRAM II, QDR SRAM, and QDRII SRAM memory
devices. You can also use the DDR I/O registers as a SERDES bypass mechanism in
LVDS applications. This section provides information about the following DDR 1/O
applications:

m DDR SDRAM, DDR2 SDRAM, and RLDRAM II memory interfaces
m QDR SRAM and QDRII SRAM memory interfaces

m High-speed interface applications

DDR SDRAM, DDR2 SDRAM and RLDRAM Il Memory Interfaces

DDR SDRAM, DDR2 SDRAM, and RLDRAM II write and read data at twice the clock
rate by capturing data on both the positive and negative edge of a clock. DDR and
DDR2 SDRAM are JEDEC standards. RLDRAM II devices have minimal latency to
support designs that require fast response times. These DDR memory interfaces use a
variety of I/O standards, such as SSTL-II, 1.8-V HSTL, LVTTL, and LVCMOS.

The DDR and DDRII SDRAM controller is available by downloading the Altera DDR
SDRAM Controller MegaCore® function from www.altera.com.

QDR SRAM and QDRII SRAM Memory Interfaces

The QDR and QDRII SRAM standard is defined jointly by Cypress Semiconductor
Corporation, Integrated Device Technology, Inc., and Micron Technology, Inc. QDR
and QDRII SRAMs have separate DDR read and write ports that pass data
concurrently. The combination of concurrent transactions and DDR signaling allows
data to be passed four times faster than by conventional SRAMs. The I/O standards
used for QDR SRAM devices are 1.5-V HSTL class I and II. QDRII SRAMSs use both
1.5-V and 1.8-V HSTL class 1.

The QDR II SDRAM controller is available by downloading the Altera QDR II
SDRAM Controller MegaCore function from www.altera.com.

High-Speed Interface Applications

High-speed interface applications use various differential standards, such as LVDS,
LVPECL, PCML, or HyperTransport technology to transfer data. These standards
often use DDR data. Stratix series devices implement high-speed standards either by
using the dedicated differential I/O SERDES blocks or by bypassing SERDES and
using the DDR I/O circuitry in SERDES bypass mode. DDR megafunctions, PLLs,
and shift registers are all used in SERDES functionality.

“%e For more information, refer to the following documents:
m The External Memory Interfaces in Stratix 1l and Stratix II GX Devices chapter in
volume 2 of the Stratix II Device Handbook
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m  The Implementing Double Data Rate 1/O Signaling in Cyclone Devices chapter in
volume 1 of the Cyclone Device Handbook

m AN 167: Using Flexible-LVDS I/O Pins in APEX II Devices

Resource Utilization and Performance

For details about the resource utilization of the ALTDDIO_IN, ALTDDIO_OUT, and
ALTDDIO_BIDIR megafunctions in various devices, and the performance of devices
that include these megafunctions, refer to the MegaWizard Plug-In Manager and the
compilation reports for each device.
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2. Parameter Settings
ARTERA ’

This section describes the parameter settings for the ALTDDIO_IN, ALTDDIO_OUT,
and ALTDDIO_BIDIR megafunctions.

You can parameterize the megafunctions using the MegaWizard™ Plug-In Manager or
the command-line interface (CLI). Altera recommends that you configure the
megafunctions using the MegaWizard Plug-In Manager.

MegaWizard Parameter Settings

“ e The options on pages 1 and 2a of the parameter editor are the same for all supported

device families. For more information, refer to the Introduction to Megafunctions User
Guide.

Table 2-1 lists the parameter settings for the ALTDDIO_IN megafunction.

Table 2-1. ALTDDIO_IN Parameter Settings

Option Description

Currently selected device family Specify the Altera® device family you are using.

Width: (bits) Specify the width of the data buses.

Select Use ‘aclr’ port for asynchronous clear (aclr). Select Use ‘aset’ port for
asynchronous preset (aset).

Asynchronus clear and

asynchronous set ports If you are not using.any of the asynchronous. clear options, se[ect Not used a_nd
specify whether registers should power up high or low by turning on/off Registers
power up high.

Select Use ‘sclr’ port for synchronous clear (sclr). Select Use ‘sset’ port for
synchronous preset (sset). If you are not using any of the synchronous clear options,
select Not used.

The synchronous reset option is available for Arria GX, Stratix 111, Stratix I,
Stratix Il GX, Stratix, Stratix GX, HardCopy Il, and HardCopy Stratix devices only.

Turn on this option to add a clock enable port that controls when data input is clocked
in. This signal prevents data from being passed through.

When enabled, the first bit of data is captured on the rising edge of the input clock. If
not enabled, the first bit of data is captured on the falling edge of the input clock.

Synchronous clear and
synchronous set ports

Use ‘inclocken’ port

Invert input clock

Table 2-2 lists the parameter settings for the ALTDDIO_OUT megafunction.

Table 2-2. ALTDDIO_OUT Parameter Settings

Option Description
Currently selected device family Specify the Altera device family you are using.
Width: (bits) Specify the width of the data buses.
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Table 2-2. ALTDDIO_OUT Parameter Settings

Option

Description

Asynchronus clear and asynchronous
set ports

Select Use “aclr’ port for asynchronous clear (aclr). Select Use ‘aset’ port for
asynchronous preset (aset).

If you are not using any of the asynchronous clear options, select Not used and
specify whether registers should power up high or low by turning on/off Registers
power up high.

Use ‘outclocken’ port

Turn on this option to add a clock enable port to control when data output is
clocked in. This signal prevents data from being passed through.

Invert ‘dataout’ output

Turn on this option to invert the dataout [1 output port. This option is available for
Cyclone Il 'and Cyclone Il devices only.

Use output enable port

Turn on this option to create an output enable input port (oe) to control when the
data is set out to the dataout port.

Use ‘oe_out’ port to connect to tri-
state output buffer(s)

Turn on this option to create an output enable port for the bidirectional padio port.
This port is available for Stratix Il and Cyclone IIl devices only.

Register ‘oe’ port

Turn on this option tp register the output-enable (oe) input port.

Delay switch-on by half a clock cycle

Turn on this option to use an additional oe register. When the additional oe register
is used, the output pin is held at high impedance for an extra half clock cycle after
the oe port goes high.

Synchronous clear and synchronous
set ports

Select Use ‘sclr’ port for synchronous clear (sclr). Select Use ‘sset’ port for
synchronous preset (sset). If you are not using any of the synchronous clear
options, select Not used.

The synchronous reset option is available for Arria GX, Stratix IIl, Stratix II,
Stratix Il GX, Stratix, Stratix GX, HardCopy Il, and HardCopy Stratix devices only.

Table 2-3 lists the parameter settings for the ALTDDIO_BIDIR megafunction.

The ALTDDIO_BIDIR megafunction combines the ALTDDIO_IN and
ALTDDIO_OUT megafunction functionality into a single megafunction, which
instantiates bidirectional DDR ports.

In Stratix II and Stratix devices, if you use the ALTDDIO_BIDIR megafunction for

your DQS signal in an external memory interface, the undelayed DQS signal is routed

to the LE.

Table 2-3. ALTDDIO_BIDIR Parameter Settings (Part 1 of 2)

Option

Description

Currently selected device family

Specify the Altera device family you are using.

Width: (bits)

Specify the width of the data buses.

Asynchronus clear and asynchronous
set ports

Select Use ‘aclr’ port for asynchronous clear (aclr). Select Use ‘aset’ port for
asynchronous preset (aset).

If you are not using any of the asynchronous clear options, select Not used and
specify whether registers should power up high or low by turning on/off Registers
power up high.

Synchronous clear and synchronous
set ports

Select Use ‘sclr’ port for synchronous clear (sclr). Select Use ‘sset’ port for
synchronous preset (sset). If you are not using any of the synchronous clear
options, select Not used.

The synchronous reset option is available for Arria GX, Stratix [, Stratix I,
Stratix Il GX, Stratix, Stratix GX, HardCopy Il, and HardCopy Stratix devices only.

Double Data Rate 1/0 (ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR) Megafunctions
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Table 2-3. ALTDDIO_BIDIR Parameter Settings (Part 2 of 2)

Option

Description

Invert ‘padio’ port

The ‘padio’ port is inverted whenever driven as an output. This option is available
for Cyclone 1l and Cyclone Il devices only.

Use ‘inclocken’ and ‘outclocken’ ports

Turn on this option to add a clock enable port to control when data input and
output are clocked in. This signal prevents data from being passed through.

Use output enable port

Turn on this option to create an output enable input port (oe) to control when the
data is set out to the dataout port.

Use oe_out port to connect to tri-state
output buffer(s)

Output enable for the bidirectional padio port. This port is available for Stratix IlI
and Cyclone Il devices only.

Register ‘oe’ port

Turn on this option to register the output-enable (oe) input port.

Delay switch-on by a half clock cycle

Turn on this option to use an additional oe register. When the additional oe register
is used, the output pin is held at high impedance for an extra half clock cycle after
the oe port goes high.

Use ‘combout’ port

Use the optional data port combout. The combout port sends data to the core,
bypassing the DDR /0 input registers. For bidirectional operation, you must
enable the dataout hand dataout_1 ports, the combout port, or both.

Use ‘dgsundelayedout’ port

Creates undelayed output from the Dgs pins. If you use the ALTDDIO_BIDIR
megafunction for your DQs signal in an external memory interface, you route the
undelayed Dgs signal to the LE, in Stratix Il and Stratix devices. This option is
available in Stratix, Stratix GX, and HardCopy Stratix devices only.

Use ‘dataout_h’ and ‘dataout_I’ ports

Enables the dataout h and dataout 1 ports.

Implement input registers in LEs

Implements the input path in logic elements. This option is available only if the
dataout_hand dataout_ 1 ports are enabled.

In the ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR parameter editor,
page 5 shows a list of the libraries needed to properly simulate the design files. You
can also enable the Quartus II software to generate a synthesis area and timing
estimation netlist for the megafunction for use by third-party tools.

On the final page of the parameter editor, specify the files you wish to have generated
for your custom megafunction. The gray check marks indicate files that are always
generated; the other files are optional and are generated only if selected (as indicated
by a green check mark). Click Finish to create an instance of the megafunction.

For more information about the wizard-generated files, refer to Quartus II Help or to

the Recommended HDL Coding Styles chapter in volume 1 of the Quartus II Handbook.

January 2013  Altera Corporation
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Command Line Interface Parameters

Expert users can choose to instantiate and parameterize the megafunction through the
command-line interface using the clear box generator command. This method
requires you to have command-line scripting knowledge.

Megafunctions User Guide.

For more information about using the clear box generator, refer to the Introduction to

Table 2—4 lists the parameters for the ALTDDIO_IN megafunction.

Table 2-4. ALTDDIO_IN Parameters

Parameter Type Required Description
width Integer Yes Width of datain, dataout_h, and dataout_1 ports.
When both aset and aclr ports are unused, power up high
power up high String No parameter is available to specify power-up state of output ports.
Values are “oN” and “OrFF”. The default setting is “oFr”.
intended device family String No This parameter is used for modeling and behavioral simulation.
Values are ON or OFF. If omitted, the default value is OFF. If this
invert input clocks String No parameter is set to ON, the inclock port must be inverted at the
connection.
Specifies whether the input channels should be implemented
implement_input_in lcell String No using logic cells. Values are ON, OFF, and UNUSED. If ommited,

the default is UNUSED. This parameter is available for all
supported devices.

Table 2-5 lists the parameters for the ALTDDIO_OUT megafunction.

Table 2-5. ALTDDIO_OUT Parameters (Part 1 of 2)

Parameter Type Required Comments

width Integer Yes Sets the width of the datain h, datain 1, and dataout ports.

When both the aset and ac1r ports are unused, the
. : power up_high parameter is available to specify the power-up

power_up_high String No state of the output ports. Values are ON and OFF. The default
setting is OFF.

intended device family String No This parameter is used for modeling and behavioral simulation.
Specifies whether the oe port is registered. Values are

oe reg String No REGISTERED, UNREGISTERED, and UNUSED. The default setting
is UNUSED.
This specifies whether the second oe register should be used.
When the second oe register is used, the output pin is held at

extend oe disable String No high impedance an extra half clock cycle after the oe port goes
high. Values are ON, OFF, and UNUSED. The default setting is
UNUSED.

1pm_hint String No Allows you to assign Altera-specific parameters in VHDL Design

Files (.vhd). The default is UNUSED.
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Table 2-5. ALTDDIO_OUT Parameters (Part 2 of 2)

Parameter Type Required Comments
. Identifies the library of parameterized modules (LPM) entity
Lpm_type String No name in VHDL Design Files.
Specifies whether to invert the dataout [] output port. Values
invert output String No are ON or OFF. This parameter is available for Cyclone Il and

Cyclone Il devices only.

Table 2-6 lists the parameters for the ALTDDIO_BIDIR megafunction.

Table 2-6. ALTDDIO_BIDIR Parameters

Parameter

Type

Required

Comments

width

Integer

Yes

Width of the datain_h, datain 1, and dataout ports.

power up_high

String

No

When both the aset and ac1r ports are unused, the
power_up_high parameter is available to specify the power-up
state of the output ports. Values are ON and OFF. The default
setting is OFF.

intended device family

String

No

This parameter is used for modeling and behavioral simulation.

lpm type

String

No

Identifies the library of parameterized modules (LPM) entity
name in VHDL Design Files.

oe_reg

String

No

Specifies whether the oe port is registered. Values are
REGISTERED, UNREGISTERED, and UNUSED. The default
setting is UNUSED.

implement input in lcell

String

No

Specifies whether the input channels should be implemented
using logic cells. Values are ON, OFF, and UNUSED. The default
is UNUSED.

extend oe_disable

String

No

Specifies whether the second oe register should be used. When
the second oe register is used, the output pin is held at high
impedance an extra half clock cycle after the oe port goes high.
Values are ON, OFF, and UNUSED. The default setting is
UNUSED.

invert output

String

No

Specifies whether to invert the dataout [] output port. Values
are ON or OFF. This parameter is available for Cyclone IIl and
Cyclone 11 devices only.

January 2013  Altera Corporation

Double Data Rate I/0 (ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR) Megafunctions

User Guide




2-6

Chapter 2: Parameter Settings
Command Line Interface Parameters

Double Data Rate 1/0 (ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR) Megafunctions
User Guide

January 2013 Altera Corporation



3. Functional Description
/ANO T2 RYA p

This chapter describes the functional description and the design examples of the
ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR megafunctions. This section
also includes prototypes, component declarations and ports of the ALTDDIO_IN,
ALTDDIO_OUT, and ALTDDIO_BIDIR megafunctions. You can use the ports to
customize the ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR megafunctions
according to your application.

DDR Device Configuration

The following sections describe how the DDR registers are configured in the Stratix
series and APEXII devices.

Input Configuration

When the IOE is configured as an input pin, input registers A; and By and latch C;
implement the input path for DDR I/O. Figure 3-1 shows an IOE configured for DDR
inputs for a Stratix series or APEXII device.

Figure 3—1. Input DDR I/0 Path Configuration for a Stratix Series or APEX Il Device

DFF
dataout_h
D Q
— INPUT Logic
I Input Register A, Array
datain DFF Latch
neg_reg_out dataout_|
D Q D Q
9 ENA
Input Register B Latch C|
inclock

Note to Figure 3-1:

(1) Onthe falling edge of the clock, the negative-edge triggered register B, acquires the first data bit. On the corresponding rising edge of the clock,
the positive-edge triggered register A, acquires the second data bit. For a successful data transfer to the logic array, the latch C, synchronizes the
data from register B, to the positive edge of the clock.
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Figure 3-2 shows an IOE configured for DDR inputs for a Stratix or Stratix II device.

Figure 3-2. Stratix Il I0E in DDR Input 1/0 Configuration

ioe_clk[7..0] VCCIO
Column, Row, &
or Local To DQS Logic < PCI Clamp (4)
Interconnect | DQS Local Block (3)
A Bus (2) A VCCIO
A Programmable
<~ Pull-Up
< l/l Resistor
Input Pin to \I \I On-Chip
Input RegisterDelay = | Termination e
[~ sclr/spreset
) Input Register
& D Q
— " clkin

A ENA

[T ce_in CLRN/PRN

| X Bus-Hold

Ir/ t Circuit
j aclapreset
< ]
I\
Chip-Wide Reset
Input Register Latch
—D Q D Q
¢1—
ENA —{ENA
CLRN/PRN CLRN/PRN
b ?
4 4

Notes to Figure 3-2:
(1) Allinput signals to the IOE can be inverted at the IOE.
(2) This signal connection is only allowed on dedicated DQ function pins.
(3) This signal is for dedicated DQS function pins only.
(4) The optional PCI clamp is only available on column 1/0 pins.
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Output Configuration

The dedicated output registers for Stratix series and APEX II devices are labeled Ag
and Bo. These positive-edge triggered registers and a multiplexer are used to
implement the output path for DDR I/O. Figure 3-3 shows the IOE configuration for
DDR outputs in Stratix series and APEX II devices.

Figure 3-3. Output DDR I/0 Path Configuration for Stratix Series and APEX Il Devices

DFF
oE (1)
D Q
OE Reg Age (2)
3
DFF
D
®e——O
Logic Array OF Rog B )
DFF
datain_|
D Q
|
™ (5) OUTPUT.
(1) 8 —>
Output Reg Ao J sataout
DFF
datain_h
D Q
e
outclock Output Reg Bo
@

Notes to Figure 3-3:

(1) The OE is active low, but the Quartus® Il software implements this as active high and automatically adds an inverter before the input to the Ao
register during compilation. If desired, you can change the OE back to active low.

(2) Register Age generates the enable signal for general-purpose DDR 1/0 applications.

(3) This select line corresponds to the delay switch-on by a half clock cycle option in the MegaWizard® Plug-In Manager.
(4) Register Bog generates the delayed enable signal for DDR SDRAM applications.

(5) The tri-state is active high by default. However, you can design it to be active low.

On the positive edge of the clock, a high data bit and a low data bit are captured in
registers Ap and Bp. The outputs of these two registers are fed to the input of a 2-to-1
multiplexer, which uses the output register clock as its control signal. A high clock
selects the data in register Bp, and a low level of the clock selects the data in register
Ao. This process doubles the data at the I/O pin.
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Figure 3-4 shows the IOE configuration for DDR outputs in Stratix series devices.

Figure 3-4. Stratix I0E in DDR Output I/0 Configuration

Column or Row

Interconnect I0E_CLK[7..0]
A A
1/0 Interconnect
[15..0]
A
-
j _D—\— OE Register
D Q _D_ Output
t,y Delay []
'-\| clkout X y
) ENA
CLRN/PRN OE Register
- Output F tep Del
I | Enable Clock co Doy
) Enable Delay
Output Clock |
Enable Delay
b—j aclr/prn — Veeio
Optional
-
Chip-Wide Reset PCI Clamp
OE Register =
D Qr— Vecio
- sclr Programmable
q Used for Pull-Up
ENA DDR SDRAM Resistor
CLRN/PRN
L
) Logic Array Output Register
shn >—||:>— to Output D Q %Y
) Register Delay Output hd A
Pin Delay
ENA clk
CLRN/PRN
"—? Drive Strength Control — /
. Open-Drain Output —
Logic Array Output Register Slew Control ——
- _D— to Output D Q
) Register Delay
NA Bus-Hold
=IN, i i
CLRN/PRN Cirouit
\ 4 \ \ 4

Bidirectional Configuration

Input and output registers are independent of each other, enabling the bidirectional
DDR I/0O path to be implemented entirely in the I/O element for Stratix, Stratix GX,
and APEX II devices. The bidirectional configuration includes an input path, an
output path, and two output enable registers.

The bidirectional path consists of two data flow paths:
m Input path active

m Output path active
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When the input path is active, the output enable disables the tri-state buffer, which
prevents data from being sent out on the output path. Disabling the tri-state buffer
prevents contention at the I/O pin. The input path behaves like the input
configuration as shown in Figure 3-1 on page 3-1. When the output path is active, the
output enable register AOE controls the flow of data from the output registers. During
outgoing transactions, the bidirectional configuration behaves like the output
configuration as shown in Figure 3-3 on page 3-3. The second output enable register
(Bog) is used for DDR SDRAM interfaces. This negative-edge register extends the
high-impedance state of the pin by a half clock cycle. This option is useful to provide
the write preamble for the DQS strobe in the DDR SDRAM interfaces. This feature is
enabled by using the Delay switch-on by a half clock cycle option in the
ALTDDIO_BIDIR megafunction in the Quartus II software. You can bypass the input
registers and latch to get a combinational output (combout) from the pin going into the
APEXII or Stratix series device. Furthermore, the input data ports (dataout_h and
dataout_1) can be disabled. These features are especially useful for generating data
strobes like DQS.
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Figure 3-5 shows the bidirectional DDR I/O configuration for Stratix series and
APEX II devices.

Figure 3-5. Bidirectional DDR 1/0 Path Configuration
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Notes to Figure 3-5:

(1) All control signals can be inverted at the Igg.

(2) The OE signal is active low, but the Quartus Il software implements this as active high and automatically adds an inverter before input to the Age
register during compilation. If desired, you can change the OE back to active low.

3) The Aqe register generates the enable signal for general-purpose DDR 1/0 applications.
4) This line selects whether the OE signal should be delayed by half a clock cycle.

6) The tri-state enable is by default active low. You can, however, design it to be active high.

(
(
(5) The B register generates the delayed enable signal for the write strobes or write clocks for memory interfaces.
(
(

7) You can also have combinational output to the 1/0 pin. This path is not shown in the diagram.
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e For more information about clock signals and output enable signals for Stratix series
or APEX II devices, refer to the following documents:
m  The Stratix II Architecture chapter in volume 1 of the Stratix II Device Handbook
m  APEXII Programmable Logic Device Family Data Sheet

“ e For more information about the DDR registers in Cyclone devices, refer to the
Implementing Double Data Rate 1/O Signaling in Cyclone Devices chapter in volume 1 of
the Cyclone Device Handbook.

DDR 1/0 Timing

Figure 3-6 shows the functional timing waveform for the input path. The signal
names are the port names used in the ALTDDIO_IN megafunction. The datain signal
is the input from the pin to the DDR circuitry. The output of register Bjis neg_reg_out.
The output of latch Cjis dataout_1, and the output of register A;is dataout_h.
dataout_h and dataout_1 feed the logic array and show the conversion of the data
from a DDR implementation to positive-edge triggered data.

Figure 3-6. DDR I/0 Input Timing Waveform
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Figure 3-7 shows a functional timing waveform example for the output path with the
output enable registered. In this example, the delay switch-on by a half clock cycle is
not turned on, so the second output enable register (Bog) is not used. The output
enable signal OE is active high and can be driven from a pin or internal logic. The data
signals datain 1 and datain_h are driven from the logic array to output registers Ag
and Bp. The dataout signal is the output from the DDR circuitry to the pin.

Figure 3-7. DDR I/0 Output Timing Waveform
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The waveform in Figure 3-7 reflects the software simulation results. The OE signal is
active low in silicon; however, the Quartus II software implements this as active high
and automatically adds an inverter before the D input of the OE register Apg. You can
change the OE back to active low, if desired.

Design Example Files

The design examples for the ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR
megafunctions in this user guide use the MegaWizard Plug-In Manager in the
Quartus II software. The design example files are available for download from the
following locations:

m  On the Documentation: Quartus II Development Software page, expand the Using
Megafunctions section and then expand the I/O section.

m On the Documentation: User Guides section of the Altera website.

The designs are simulated in the ModelSim®-Altera software to generate a waveform
display of the device behavior. You should be familiar with the ModelSim-Altera
software before using the design examples. To get started with the ModelSim-Altera
software, refer to the ModelSim-Altera Software Support page on the Altera website.
The support page includes links to such topics as installation, usage, and
troubleshooting.
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Design Example 1: 8-Bit DDR Divider Using ALTDDIO_IN and

ALTDDIO_OUT

This section presents a design example that uses the ALTDDIO_IN and
ALTDDIO_OUT megafunctions to generate a divider. This example uses the
MegaWizard Plug-In Manager in the Quartus II software.

In this example, you perform the following activities:

Create a divider using the ALTDDIO_IN, ALTDDIO_OUT, and LPM_DIVIDE
megafunctions and the MegaWizard Plug-in Manager

Implement the design and assign the Stratix EP1S10F780C6 device to the project

Compile and simulate the design

Generate a Divider Using ALTDDIO_IN and ALTDDIO_OUT

The new megafunction created in this example is added to the top-level file in your
Quartus II project.

Create the ALTDDIO_IN Module

Follow these steps to create the ALTDDIO IN module:

1.

Unzip the ALTDDIO_DesignExample_ex1.zip file to any working directory on
your PC.

In the Quartus II software, open the ex1.qar project.
On the Tools menu, select MegaWizard Plug-In Manager.

In the MegaWizard Plug-In manager dialog box, select Create a new custom
megafunction variation, and click Next. The MegaWizard Plug-In Manager page
displays.

In the MegaWizard Plug-In Manager pages, select or verify the configuration
settings shown in Table 3-9. Click Next to advance from one page to the next.

Table 3-1. Configuration Settings for Design Example 1 (ALTDDIO_IN) (Part 1 of 2)
MegaWizard Plug-In Manager Page | MegaWizard Plug-In Manager Configuration Setting Value
Which megafunction would you like to customize In the 1/0 folder, select
ALTDDIO_IN
Which device family will you be using? Stratix
2 Which type of output file do you want to create? VHDL

What name do you want for the output file? ddin
Return to this page for another create operation Turned off
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Table 3—-1. Configuration Settings for Design Example 1 (ALTDDIO_IN) (Part 2 of 2)

MegaWizard Plug-In Manager Page | MegaWizard Plug-In Manager Configuration Setting Value

Currently selected device family Stratix IV
Match project/default Turned on
Width: (bits) 8
Use ‘aclr’ port Turned off
Use ‘aset’ port Turned off

3 Not used Turned on
Registers power up high Turned off
Use ‘scir’ port Turned off
Use ‘sset’ port Turned off
Not used Turned on
Use ‘inclocken’ port Turned off
Invert input clock Turned off

4 Generate netlist Turned off
Variation file Turned on
Quartus Il IP file Turned on
Quartus Il symbol file (.bsf) Turned off

5 Instantiation template file Turned on
Verilog HDL black box file (_bb.v) Turned on
AHDL Include file (.inc) Turned off
VHDL component declaration file (.cmp) Turned on
PinPlanner poris file (.PPF) Turned on

6. Click Finish.

The ALTDDIO IN module is now built.

Create the ALTDDIO _OUT Module

Follow these steps to create the ALTDDIO OUT module:
1. On the Tools menu, select MegaWizard Plug-In Manager.

2. In the MegaWizard Plug-In manager dialog box, select Create a new custom
megafunction variation, and click Next. The MegaWizard Plug-In Manager page
displays.
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3. Inthe MegaWizard Plug-In Manager pages, select or verify the configuration
settings shown in Table 3-9. Click Next to advance from one page to the next.

Table 3-2. Configuration Settings for Design Example 1 (ALTDDIO_OUT)

MegaWizard Plug-In Manager Page | MegaWizard Plug-In Manager Configuration Setting Value
Which megafunction would you like to customize In the 1/0 folder, select
ALTDDIO_OUT

Which device family will you be using? Stratix

2 Which type of output file do you want to create? VHDL
What name do you want for the output file? ddout
Return to this page for another create operation Turned off
Currently selected device family Stratix IV
Match project/default Selected
Width: (bits) 8
Use ‘aclr’ port Turned off
Use ‘aset’ port Turned off
Not used Turned on
Registers power up high Turned off
Not used Turned on

3 Use ‘outclocken’ port Turned off
Invert ‘dataout’ output Turned off
Use output enable port Turned off
Use ‘oe_out’ port to connect to tri-state output Turned off
huffer(s)
Register ‘oe’ port Turned off
Delay switch-on by half a clock cycle Turned off
Use ‘sclr’ port Turned off
Use ‘sset’ port Turned off
Not used Turned on

4 Generate netlist Turned off
Variation file Turned on
Quartus I IP file Turned on
Quartus Il symbol file (.bsf) Turned off

5 Instantiation template file Turned on
Verilog HDL black box file (_bb.v) Turned on
AHDL Include file (.inc) Turned off
VHDL component declaration file (.cmp) Turned on
PinPlanner ports file (.PPF) Turned on

4. Click Finish.

The ALTDDIO OUT module is now built.
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Create the LPM_DIVIDE Module

Follow these steps to create the 1pm divide module:

1. On the Tools menu, select MegaWizard Plug-In Manager.

2. In the MegaWizard Plug-In manager dialog box, select Create a new custom
megafunction variation, and click Next. The MegaWizard Plug-In Manager page

displays.

3. In the MegaWizard Plug-In Manager pages, select or verify the configuration
settings shown in Table 3-9. Click Next to advance from one page to the next.

Table 3-3. Configuration Settings for Design Example 1 (LPM_DIVIDE)

MegaWizard Plug-In Manager Page | MegaWizard Plug-In Manager Configuration Setting Value
Which megafunction would you like to customize In the Arithmetic folder,
select LPM_DIVIDE
Which device family will you be using? Stratix
2 Which type of output file do you want to create? VHDL
What name do you want for the output file? Ip_div
Return to this page for another create operation Turned off
Currently selected device family Stratix IV
Match project/default Turned on
3 How wide should the ‘numerator’ input bus be? 8
How wide should the ‘denominator’ input bus bhe? 8
Numerator Representation Select Unsigned
Denominator Representation Select Unsigned
Do you want to pipeline the function? Select Yes, | want an
output latency of 1 clock
cycle
Create an Asynchronous Clear input Turned off
4 Create a Clock Enable input Turned off
Which do you wish to optimize? Select Default
Optimization
Always return a positive remainder? Select Yes
5 Generate netlist Turned off
Variation file Turned on
Quartus I IP file Turned on
Quartus 1l symbol file (.bsf) Turned off
6 Instantiation template file Turned on
Verilog HDL black box file (_bb.v) Turned on
AHDL Include file (.inc) Turned off
VHDL component declaration file (.cmp) Turned on
PinPlanner ports file (.PPF) Turned on

4. Click Finish.

The 1pm_divide module is now built.
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Create a Divider

Use the following steps to combine the ALTDDIO_IN, ALTDDIO OUT, and lpm divide
modules to create a divider.

1. In the Quartus II software, open the file ex1.vhd.

2. On the Project menu, click Add/Remove Files in Project. The File Settings dialog
box displays.

3. In the File Settings dialog box, click (...) after File name and browse for exl.vhd in
the project folder.

4. Select ex1.vhd and click Add.
5. Click OK.

The top-level file is added to the project. You have now created the complete design
file.

In the complete divider design, the DDR_IN OUT H[7..0] signals are the numerator
and the DDR_IN OUT L[7..0] signals are the denominator. The DDR_IN OUT H[7..0]
and DDR_IN OUT L[7..0] sets of signals are passed into the 1p_div function where the
quotient and remainder are calculated. The divider calculates the quotient and
remainder through a one-stage pipeline. The quotient and remainder are fed into the
ddout module and also to REG_DDROUT8 IN H[7..0] and REG DDROUT8 IN L[7..0].
The ddout module then drives the data out through pins DDR_IN8_OUT[7..0] at
double the data rate.

Implement the Divider Design

This section describes how to assign the Stratix EP1S10F780C6 device to the project
and how to compile the project.

1. With the ex1.qar project open, on the Assignments menu, click Settings. The
Settings dialog box displays.

In the Category list, select Device. The Device dialog box displays.
From the Family list, select Stratix.

Under Target device, select Specific device selected in ‘Available devices’ list.

ISR R

Under Show in “Available devices’ list, select FBGA as the Package, Pin count of
780, Speed grade of 6, and turn on Show advanced devices.

Click OK.

o

7. On the Processing menu, click Start Compilation.

8. When the Full Compilation was successful box displays, click OK.
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Functional Results—Simulate the Divider Design in the ModelSim-Altera

Software

Simulate the design in the ModelSim-Altera software to generate a waveform display
of the device behavior.

To set up the ModelSim-Altera software, follow these steps:

1.

v ® N o e

Unzip the ALTDDIO_ex1_msim.zip file to any working directory on your PC.

Browse to the folder in which you unzipped the files and open the
ALTDDIO_ex1.do file in a text editor.

In line 1 of the ALTDDIO_ex1.do file, replace <insert_directory_path_here> with the
directory path of the appropriate library files. For example,
C:/altera/71/modelsim ae/altera/verilog/stratix

On the File menu, click Save.

Start ModelSim-Altera.

On the File menu, click Change Directory.

Select the folder in which you unzipped the files. Click OK.
On the Tools menu, click Execute Macro.

Select the ALTDDIO_ex1.do file and click Open. This is a script file for ModelSim
that automates all the necessary settings for the simulation.

10. Verify the results by looking at the Waveform Viewer window.

You can rearrange signals, remove redundant signals, and change the radix by
modifying the script in the ALTDDIO_ex1.do file. Figure 3-8 shows the expected
simulation results in ModelSim-Altera software.

Figure 3-8. ModelSim Simulation Results
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Design Example 2: 8-Bit DDR Divider Using ALTDDIO_BIDIR

This section presents a design example that uses the ALTDDIO_BIDIR megafunction
to generate a divider. This example uses the MegaWizard Plug-In Manager in the
Quartus II software. As you go through the wizard, each page is described in detail.
When you are finished with this example, you can incorporate it into your overall
project.

In this example, you perform the following tasks:

Create a divider using the ALTDDIO_BIDIR and lpm_divide megafunctions and
the MegaWizard Plug-in Manager

Implement the design and assign the Stratix EP1S10F780C6 device to the project

Compile and simulate the design

Generate a Divider Using ALTDDIO_BIDIR

The new megafunction created in this example is added to the top-level file in your
Quartus II project.

Create the ALTDDIO_BIDIR Module

Follow these steps to create the ALTDDIO_BIDIR module:

1.

Unzip the ALTDDIO_DesignExample_ex2.zip file to any working directory on
your PC.

In the Quartus II software, open the ex2.qar project .
On the Tools menu, select MegaWizard Plug-In Manager.

In the MegaWizard Plug-In manager dialog box, select Create a new custom
megafunction variation, and click Next. The MegaWizard Plug-In Manager page
displays.

In the MegaWizard Plug-In Manager pages, select or verify the configuration
settings shown in Table 3-9. Click Next to advance from one page to the next.

Table 3-4. Configuration Settings for Design Example 1 (ALTDDIO_BIDIR) (Part 1 of 2)

MegaWizard Plug-In Manager Page | MegaWizard Plug-In Manager Configuration Setting Value
Which megafunction would you like to customize In the 1/0 folder, select
ALTDDIO_BIDIR
Which device family will you be using? Stratix
22 Which type of output file do you want to create? VHDL
What name do you want for the output file? alt_bid
Return to this page for another create operation Turned off
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Table 3—-4. Configuration Settings for Design Example 1 (ALTDDIO_BIDIR) (Part 2 of 2)

MegaWizard Plug-In Manager Page | MegaWizard Plug-In Manager Configuration Setting Value
Currently selected device family Stratix IV
Match project/default Turned on
Width: (bits) 8
Use ‘aclr’ port Turned off
Use ‘aset’ port Turned off
3 Not used Turned on
Registers power up high Turned off
Use ‘scir’ port Turned off
Use ‘sset’ port Turned off
Not used Turned on
Invert ‘padio’ port Turned off
Use ‘inclocken’ and ‘outclocken’ ports Turned off
Use output enable port Turned on
Use ‘oe_out’ port to connect to tri-state output Turned off
bhuffer(s)
Register ‘oe’ port Turned off
4 Delay switch-on by half a clock cycle Turned off
Use ‘combout’ port Turned off
Use ‘dqsundelayedout’ port Turned off
Use ‘dataout_h’ and ‘dataout_I” ports Turned on
Implement input registers in LEs Turned off
5 Generate netlist Turned off
Variation file Turned on
Quartus I IP file Turned on
Quartus 1l symbol file (.bsf) Turned off
6 Instantiation template file Turned on
Verilog HDL black box file (_bb.v) Turned on
AHDL Include file (.inc) Turned off
VHDL component declaration file (.cmp) Turned on
PinPlanner ports file (.PPF) Turned on

6. Click Finish.

The ALTDDIO BIDIR module is now built.
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Create the Ipm_divide Module

To generate a divider, follow the steps shown in “Create the LPM_DIVIDE Module”
on page 3-12.

Create a Divider

Use the following steps to combine the ALTDDIO BIDIR and lpm divide modules to
create a divider.

Follow these steps to create a top-level VHDL file:
1. In the Quartus II software, with the ex2.qar project open, open the file ex2.vhd.

2. On the Project menu, click Add/Remove File in Project. The File Settings page
displays.

3. In the File Settings window, click (...) after File name and browse for ex2.vhd in
the project folder.

4. Select ex2.vhd and click Add.
5. Click OK.

The top-level file is added to the project. You have now created the complete design
file.

This design implements the same divider as that in Design Example 1, but the
functionality of the ALTDDIO IN and ALTDDIO OUT modules is implemented in a single
megafunction, ALTDDIO_BIDIR. The bidirectional pins DDR_BIDIR8 [7..0] receive
data at double the clock rate. The DDRBIDIRS OUT H[7..0] signals are the numerator
and the DDRBIDIR8 OUT L[7..0] signals are the denominator. These two sets of
signals are passed to the 1pm _divide module where the quotient and remainder are
calculated. The divider calculates the quotient and remainder with a one-stage
pipeline. The quotient and remainder are then fed via signals quotient [7..0] and
remain[7..0] back to the ALTDDIO_BIDIR megafunction. The ALTDDIO_BIDIR
megafunction then drives the data out through pins DDR_BIDIR8[7..0] at double the
data rate.

Implement the Divider Design

This section describes how to assign the Stratix EP1S10F780C6 device to the project
and compile the project.

1. With the ex2.qar project open, on the Assignments menu, click Settings. The
Settings dialog box displays.

In the Category list, select Device.
To answer Which device family will you be using?, select Stratix.
Under Target device, select Specific device selected in “Available devices’ list.

In the Available devices list, select EP1S10F780C6.

AN T e

Under Show in “Available devices’ list, select FBGA as the Package, Pin count of
780, Speed grade of 6, and turn on Show Advanced Devices.

7. Click OK.
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8.
9.

On the Processing menu, click Start Compilation.

When the Full Compilation was successful box displays, click OK.

Functional Results—Simulate the Divider Design in the ModelSim-Altera

Software

Simulate the design in the ModelSim-Altera software to generate a waveform display
of the device behavior.

To set up the ModelSim-Altera software, follow these steps:

1.

v ® N o e

Unzip the ALTDDIO_ex2_msim.zip file to any working directory on your PC.

Browse to the folder in which you unzipped the files and open the
ALTDDIO_ex2.do file in a text editor.

In line 1 of the ALTDDIO_ex2.do file, replace <insert_directory_path_here> with the
directory path of the appropriate library files. For example,
C:/altera/71/modelsim ae/altera/verilog/stratix

On the File menu, click Save.

Start ModelSim-Altera.

On the File menu, click Change Directory.

Select the folder in which you unzipped the files. Click OK.
On the Tools menu, click Execute Macro.

Select the ALTDDIO_ex2.do file and click Open. This is a script file for ModelSim
that automates all the necessary settings for the simulation.

10. Verify the results by looking at the Waveform Viewer window.

You can rearrange signals, remove redundant signals, and change the radix by
modifying the script in the ALTDDIO_ex2.do file. Figure 3-9 shows the expected
simulation results in ModelSim-Altera software.

Figure 3-9. ModelSim Simulation Results

Cursor 1 BO000 ps
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ALTDDIO_IN Megafunction Ports

Figure 3-10 shows the ports for the ALTDDIO_IN megafunction.

Figure 3-10. ALTDDIO_IN Ports

altddio_in

datain[ ] dataout_h[ ]
inclock dataout_I[ ]

inclocken
aclr

aset

Table 3-5 and Table 36 list the input and output ports for the ALTDDIO_IN
megafunction.

Table 3-5. ALTDDIO_IN Input Ports

Name Required Description

DDR input data port. Input port wiDTH wide. The datain port should be directly fed from an

datain(] ves input pin in the top-level design.

inclock Ves (i:Loccll<os;i]g{nSz?Ig’;(;|s.ample the DDR input. The datain port is sampled on each clock edge of the
inclocken No Clock enable for the data clock

aclr No Asynchronous clear input. The ac1r and aset ports cannot be connected at the same time.
aset No Asynchronous set input. The aclr and aset ports cannot be connected at the same time.

Synchronous clear input. The sc1r and sset ports cannot be connected at the same time.
sclr No The sclr port is available for Arria GX, Stratix I, Stratix |I, Stratix Il GX, Stratix, Stratix GX,
HardCopy II, and HardCopy Stratix devices only. (1)

Synchronous set input. The sclr and sset ports cannot be connected at the same time. The
sset No sset port is available for Arria GX, Stratix IlI, Stratix II, Stratix | GX, Stratix, Stratix GX,
HardCopy I, and HardCopy Stratix devices only. (7

Note to Table 3-5:
(1) When designing with Stratix Il devices, when sclr is asserted, it synchronously presets both the input path and resynchronization register.

Table 3-6. ALTDDIO_IN Output Ports

Name Required Description
dataout_h(] Yes Data sampled from datain[] port at the rising edge of the inclock signal.
dataout_1[] Yes Data sampled from datain[] port at the falling edge of the inclock signal.
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ALTDDIO_OUT Megafunction Ports

Figure 3-11 shows the ports for the ALTDDIO_OUT megafunction.

Figure 3-11. ALTDDIO_OUT Ports

altddio_out

datain_h[ ] dataout] ]
datain_I[ ]

outclock

outclocken

oe

aclr

aset

Table 3-7 and Table 3-8 list the input and output ports for the ALTDDIO_OUT
megafunction.

Table 3-7. ALTDDIO_OUT Input Ports

Name Required Description
datain h[] Yes Input data for rising edge of outclock port. Input port WIDTH wide.
datain 1[] Yes Input data for falling edge of outclock port. Input port WIDTH wide.
outclock Yes glllotc:lsoigc]]r{lasli;on;(la.gister data output. dataout port outputs DDR data on each level of
outclocken No Clock enable for outclock port.
aclr No Asynchronous clear input. The ac1r and aset ports cannot be connected at the same time.
aset No Asynchronous set input. The aclr and aset ports cannot be connected at the same time.
e No Output enable for the dataout port. Active-high signal. You can add an inverter if you need

an active-low oe.

Synchronous clear input. The sclr and sset ports cannot be connected at the same time.
sclr No The sclr port is available for Arria GX, Stratix 111, Stratix II, Stratix | GX, Stratix, Stratix GX,
HardCopy I, and HardCopy Stratix devices only.

Synchronous set input. The sc1r and sset ports cannot be connected at the same time. The
sset No sset port is available for Arria GX, Stratix |II, Stratix II, Stratix | GX, Stratix, Stratix GX,
HardCopy I, and HardCopy Stratix devices only.

Table 3-8. ALTDDIO_OUT Output Ports

Name Required Description Comments

Output port wIDTH wide. dataout port should directly feed an
output pin in top-level design.

Output enable for the Output port [wrpTH-1..0] wide. This port is available for Stratix IlI
bidirectional padio port. | and Gyclone Il devices only.

dataout [] Yes DDR output data port.

oe_out No
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ALTDDIO_BIDIR Megafunction Ports

Figure 3-12 shows the ports for the ALTDDIO_BIDIR megafunction.

Figure 3-12. ALTDDIO_BIDIR Ports

altddio_bidir

datain_h[ ] dataout_h[ ]
datain_I[ ] dataout_I[ ]
inclock padio[ ]
inclocken combout| ]
outclock dgsundelayedout] ]
outclocken

oe

Table 3-9 lists the input ports, Table 3-10 list the output ports, and Table 3-11 lists the
bidirectional ports for the ALTDDIO_BIDIR megafunction.

Table 3-9. ALTDDIO_BIDIR Input Ports

Name Required Description
datain h[l Yes Input data to be output to.the padio port at the rising edge of the outclock port. Input port
— [(WIDTH) - (1)..0] wide.
datain 1] Ves Input data to be output tq the padio port at the falling edge of the outclock port. Input port
- [(WIDTH) - (1)..0] wide.
inclock Yes Qlock S|gna}| to sample the DDR input. The padio port is sampled on each clock edge of the
inclock signal.
inclocken No Clock enable for the inclock port.
outclock Yes Clock signal to r.eg|ster the data output. The padio port outputs the DDR data on each edge of
the outclock signal.
outclocken No Clock enable for the outclock port.
aclr No Asynchronous clear input. The ac1r and aset ports cannot be connected at the same time.
aset No Asynchronous set input. The aclr and aset ports cannot be connected at the same time.
No Output enable for the bidirectional padio port. If the oe port is not connected, then the padio
¢ port is an output port.
Synchronous clear input. The sclr and sset ports cannot be connected at the same time. The
sclr No sclr port is available for Arria GX, Stratix IlI, Stratix II, Stratix || GX, Stratix, Stratix GX,
HardCopy II, and HardCopy Stratix devices only. (7
Synchronous set input. The sclr and sset ports cannot be connected at the same time. The
sset No sset port is available for Arria GX, Stratix IlI, Stratix II, Stratix Il GX, Stratix, Stratix GX,
HardCopy I, and HardCopy Stratix devices only. (7

Note to Table 3-9:
(1) When designing with Stratix
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Table 3-10. ALTDDIO_BIDIR Output Ports

Description

dataout hf{]

Yes

Data sampled from the padio port at the rising edge of the inclock signal. Qutput
port [wIDTH-1..0] wide.

Data sampled from the padio port at the falling edge of the inclock signal. Output

dataout_LI] Yes | port [wIDTH-1..0] wide.

combout [] @/ No Combinational output directly fed by the padio port.

dgsundelayedout [] No Undelayed output from the DQS pins. Output port [wIDTH-1..0] wide. @

e out No Output enable for the bidirectional padio port. Qutput port [wipTH-1..0] wide. This

port is available for Stratix Il and Cyclone Ill devices only.

Notes to Table 3—10:

(1) This port is available for Stratix series, HardCopy Stratix, Cyclone series, and APEX Il devices only.
(2) This port is available for Stratix and HardCopy Stratix devices only.

Table 3-11. ALTDDIO_BIDIR Bidirectional Port

Name Required Description
Bidirectional DDR port that should directly feed a bidirectional pin in the top-level design. The
padio[] Yes DDR data is transmitted and received on this bidirectional port. Bidirectional port [ (WIDTH) -
(1) ..0] wide.
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Prototypes and Component Declarations

This section describes the prototypes and component declarations of the
ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR megafunctions.

Verilog HDL Prototype for the ALTDDIO_IN Megafunction

You can locate the following Verilog HDL prototype in the Verilog Design File (.v)
altera_mf.v in the <Quartus I installation directory>\eda\synthesis directory.

modulealtddio in

#( parameterintended device family = "unused",
parameterimplement input in lcell = "ON",
parameterinvert input clocks = "OFF",
parameterpower up_high = "OFF",

parameterwidth = 1,

parameterlpm type = "altddio in",
parameterlpm hint = "unused")

(  inputwireaclr,
inputwireaset,

inputwire [width-1:0]datain,

outputwire [width-1:0]dataout h,

outputwire [width-1:0]dataout 1,
inputwireinclock,

inputwireinclocken,

inputwiresclr,

inputwiresset) /* synthesis syn black box=1 */;

endmodule //altddio_in

VHDL Component Declaration for the ALTDDIO_IN Megafunction

You can locate the following VHDL Design File (.vhd) altera_mf.vhd in the
<Quartus 1l installation directory>\libraries\vhdl\altera_mf directory.

component altddio in

generic (

intended device_family:string := "unused";
implement input in lcell:string := "ON";
invert_input_clocks:string := "OFF";
power up high:string := "OFF";

width: natural;

lpm hint:string := "UNUSED";
lpm type:string := "altddio in"
) ;
port (
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aclr: in std logic := '0';

aset: 1in std logic := '0';

datain:in std_logic_vector (width-1 downto 0);
dataout_h:out std logic_ vector (width-1 downto 0);
dataout l:out std logic vector (width-1 downto 0);

inclock:in std_logic;

inclocken:in std logic := '1';
sclr: in std logic := '0';
sset: 1in std logic := '0'

)i

end component;

Verilog HDL Prototype for the ALTDDIO_OUT Megafunction

You can locate the following Verilog HDL prototype in the Verilog Design File (.v)
altera_mf.v in the <Quartus Il installation directory>\eda\synthesis directory.
modulealtddio out
#( parameterintended _device_ family = "unused",
parameterextend oe disable = "OFF",
parameterinvert output = "OFF",
parameteroe reg = "UNREGISTERED",
parameterpower up_high = "OFF",

parameterwidth = 1,

parameterlpm type = "altddio out",
parameterlpm hint = "unused")

(  inputwireaclr,
inputwireaset,

inputwire [width-1:0]datain_h,

inputwire [width-1:0]datain 1,

outputwire [width-1:0]dataout,

inputwireoe,

outputwire [width-1:0]oe out,
inputwireoutclock,

inputwireoutclocken,

inputwiresclr,

inputwiresset) /* synthesis syn black box=1 */;

endmodule //altddio_out
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VHDL Component Declaration for the ALTDDIO_OUT Megafunction

You can locate the following VHDL Design File (.vhd) altera_mf.vhd in the
<Quartus 1l installation directory>\libraries\vhdl\altera_mf directory.

component altddio out
generic (
intended device_family:string := "unused";
extend oe disable:string := "OFF";
invert output:string := "OFF";
oe reg:string := "UNREGISTERED";
power up high:string := "OFF";

width: natural;

lpm hint:string "UNUSED" ;
lpm type:string := "altddio out"
)i

port (

aclr: in std logic o'
aset: 1in std logic := '0';
datain_h:in std_logic_vector (width-1 downto 0) ;
datain 1:in std logic_vector (width-1 downto 0);
dataout:out std _logic_vector (width-1 downto 0);
oe : 1in std logic := '1';
oe out:out std logic_vector (width-1 downto 0);

outclock:in std_logic;

outclocken:in std logic := '1';
sclr: in std logic := '0';
sset: in std logic := '0'

)i

end component;

Verilog HDL Prototype for the ALTDDIO_BIDIR Megafunction

You can locate the following Verilog HDL prototype in the Verilog Design File (.v)
altera_mf.v in the <Quartus Il installation directory>\eda\synthesis directory.

modulealtddio bidir

#( parameterintended device family = "unused",
parameterextend oe disable = "OFF",
parameterimplement_input_in_lcell = "OFF",
parameterinvert output = "OFF",
parameteroe reg = "UNREGISTERED",

parameterpower_up_high = "OFF",
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parameterwidth = 1,

parameterlpm type = "altddio bidir",
parameterlpm hint = "unused")

( inputwireaclr,
inputwireaset,

outputwire [width-1:0] combout,
inputwire [width-1:0]datain h,
inputwire [width-1:0]datain 1,
outputwire [width-1:0]dataout_h,
outputwire [width-1:0]dataout 1,
outputwire [width-1:0] dgsundelayedout,
inputwireinclock,

inputwireinclocken,

inputwireoe,

outputwire [width-1:0]oe_out,
inputwireoutclock,
inputwireoutclocken,

inoutwire [width-1:0]padio,
inputwiresclr,

inputwiresset) /* synthesis syn black box=1 */;

endmodule //altddio bidir

VHDL Component Declaration for the ALTDDIO_BIDIR Megafunction

You can locate the following VHDL Design File (.vhd) altera_mf.vhd in the
<Quartus II installation directory>\libraries\vhdl\altera_mf directory.

component altddio_bidir
generic (

intended device family:string := "unused";
extend oe disable:string := "OFF";
implement input in lcell:string := "OFF";
invert output:string := "OFF";
oe_reg:string := "UNREGISTERED";
power up high:string := "OFF";

width: natural;

lpm hint:string := "UNUSED";
lpm type:string := "altddio bidir"
)
port (
aclr: in std logic := '0';
aset: 1in std logic := '0';
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combout:out std logic vector (width-1 downto 0) ;
datain h:in std logic_vector (width-1 downto 0);
datain 1:in std_logic_vector (width-1 downto 0);
dataout_h:out std logic_ vector (width-1 downto 0);
dataout l:out std logic vector (width-1 downto 0);
dgsundelayedout:out std logic_vector (width-1 downto 0) ;
inclock:in std _logic := '0';
inclocken:in std logic := '1';
oe : 1in std logic := '1';
oe_out:out std logic_vector (width-1 downto 0);
outclock:in std logic := '0';
outclocken:in std logic := '1';
padio: inout std logic vector (width-1 downto 0);
sclr: in std logic := '0';
sset: 1in std logic := '0'

)i

end component;

VHDL LIBRARY-USE Declaration

The VHDL LIBRARY-USE declaration is not required if you use the VHDL
component declaration.

LIBRARY altera mf;
USE altera mf.altera mf components.all;
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This chapter provides additional information about the document and Altera.

Document Revision History

The following table lists the revision history for this document.

Date Version Changes
January 2013 6.1 Updated to correct content error in “DDR 1/0 Timing” on page 3—7.
February 2012 6.0 Updated to refelect new GUI changes.

September 2010 5.0 Added ports and parameters.

Updated for Quartus Il software version 7.1:

m Updated for Arria GX and Cyclone 11l devices.

m Updated and renamed “DDR MegaWizard Plug-Ins Page Descriptions” section.

m Added parameter to the ALTDDIO_IN megafunction.

m Added “Referenced Documents” section.

Updated “Revision History” and “How to Contact Altera” sections.

March 2007 4.1 Added Cyclone Il device to list of supported devices.

Updated to reflect Quartus 11 6.0 release, added ModelSim simulation information, updated

June 2007 4.2

July 2006 4.0 .
design examples.
March 2005 3.0 Updated to reflect new GUI changes.
December 2004 2.0 Updated to reflect new document organization and GUI changes.

How to Contact Altera

To locate the most up-to-date information about Altera products, refer to the

following table.
Contact (" Contact Method Address
Technical support Website www.altera.com/support
) N Website www.altera.com/training
Technical training - -
Email custrain@altera.com
Product literature Website www.altera.com/literature
Nontechnical support (general) Email nacomp@altera.com
(software licensing) Email authorization@altera.com

Note to Table:
(1) You can also contact your local Altera sales office or sales representative.
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Typographic Conventions

The following table shows the typographic conventions this document uses.

Visual Cue

Bold Type with Initial Capital
Letters

Indicate command names, dialog box titles, dialog box options, and other GUI
labels. For example, Save As dialog box. For GUI elements, capitalization matches
the GUI.

bold type

Indicates directory names, project names, disk drive names, file names, file name
extensions, software utility names, and GUI labels. For example, \qdesigns
directory, D: drive, and chiptrip.gdf file.

Italic Type with Initial Capital Letters

Indicate document titles. For example, Stratix IV Design Guidelines.

italic type

Indicates variables. For example, n+ 1.

Variable names are enclosed in angle brackets (< >). For example, <file name>and
<project name>.pof file.

Initial Capital Letters

Indicate keyboard keys and menu names. For example, the Delete key and the
Options menu.

“Subheading Title”

Quotation marks indicate references to sections in a document and titles of
Quartus Il Help topics. For example, “Typographic Gonventions.”

Courier type

Indicates signal, port, register, bit, block, and primitive names. For example, datal,
tdi, and input. The suffix n denotes an active-low signal. For example, resetn.

Indicates command line commands and anything that must be typed exactly as it
appears. For example, c:\gdesigns\tutorial\chiptrip.gdf.

Also indicates sections of an actual file, such as a Report File, references to parts of
files (for example, the AHDL keyword SUBDESIGN), and logic function names (for
example, TRI).

« An angled arrow instructs you to press the Enter key.

1,2,3,and Numbered steps indicate a list of items when the sequence of the items is important,
a., b.,c., andsoon such as the steps listed in a procedure.

HEEn Bullets indicate a list of items when the sequence of the items is not important.
1= The hand points to information that requires special attention.

© The question mark directs you to a software help system with related information.
e The feet direct you to another document or website with related information.

L The multimedia icon directs you to a related multimedia presentation.

CAUTION

A caution calls attention to a condition or possible situation that can damage or
destroy the product or your work.

A warning calls attention to a condition or possible situation that can cause you
injury.

The envelope links to the Email Subscription Management Center page of the Altera
website, where you can sign up to receive update notifications for Altera documents.

WARNING

The feedback icon allows you to submit feedback to Altera about the document.
Methods for collecting feedback vary as appropriate for each document.

Double Data Rate 1/0 (ALTDDIO_IN, ALTDDIO_OUT, and ALTDDIO_BIDIR) Megafunctions

User Guide

January 2013 Altera Corporation


https://www.altera.com/subscriptions/email/signup/eml-index.jsp

	Contents
	1. About These Megafunctions
	Features
	Device Support
	Common Applications
	DDR SDRAM, DDR2 SDRAM and RLDRAM II Memory Interfaces
	QDR SRAM and QDRII SRAM Memory Interfaces
	High-Speed Interface Applications

	Resource Utilization and Performance

	2. Parameter Settings
	MegaWizard Parameter Settings
	Command Line Interface Parameters

	3. Functional Description
	DDR Device Configuration
	Input Configuration
	Output Configuration
	Bidirectional Configuration

	DDR I/O Timing
	Design Example Files
	Design Example 1: 8-Bit DDR Divider Using ALTDDIO_IN and ALTDDIO_OUT
	Generate a Divider Using ALTDDIO_IN and ALTDDIO_OUT
	Create the ALTDDIO_IN Module
	Create the ALTDDIO_OUT Module
	Create the LPM_DIVIDE Module

	Create a Divider
	Implement the Divider Design
	Functional Results — Simulate the Divider Design in the ModelSim-Altera Software

	Design Example 2: 8-Bit DDR Divider Using ALTDDIO_BIDIR
	Generate a Divider Using ALTDDIO_BIDIR
	Create the ALTDDIO_BIDIR Module
	Create the lpm_divide Module

	Create a Divider
	Implement the Divider Design
	Functional Results—Simulate the Divider Design in the ModelSim-Altera Software

	ALTDDIO_IN Megafunction Ports
	ALTDDIO_OUT Megafunction Ports
	ALTDDIO_BIDIR Megafunction Ports
	Prototypes and Component Declarations
	Verilog HDL Prototype for the ALTDDIO_IN Megafunction
	VHDL Component Declaration for the ALTDDIO_IN Megafunction
	Verilog HDL Prototype for the ALTDDIO_OUT Megafunction
	VHDL Component Declaration for the ALTDDIO_OUT Megafunction
	Verilog HDL Prototype for the ALTDDIO_BIDIR Megafunction
	VHDL Component Declaration for the ALTDDIO_BIDIR Megafunction
	VHDL LIBRARY-USE Declaration


	Additional Information
	Document Revision History
	How to Contact Altera
	Typographic Conventions


